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Storyboard Pro 7.0.4 Release Notes

Here is the list of changes in Storyboard Pro 7.0.4, build 17.10.4.17497 (2021-10-04):
o Fixed Issues on page 3

o Generalon page 3

« Scripting on page 3

Fixed Issues

The following issues have been fixed in this release of Storyboard Pro:

General

o Random crash when performing various drag and drop operations under the latest Windows 10 using
an NVIDIA Quadro GPU. SB-4324

Scripting

« Movies generated using the exportToMovie ()function from the ExportManager class in batch mode
don’t have audio. SB-4395

« Rendered images are randomly expanded to frame all the camera frames when using the
exportToFCPXML function from the ExportManager class. SB-4328
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Storyboard Pro 7.0.3 Release Notes

Here is the list of changes in Storyboard Pro 7.0.3, build 17.10.3.16542 (2020-11-27):

NOTE

Storyboard Pro does not natively support the new Apple M1 chip. On systems using the new
Apple M1 chip, Storyboard Pro runs through Apple’s Rosetta 2. This may cause compatibility
issues when running on the new ARM-based macOS systems.

Fixed Issues

The following issues have been fixed in this release:

o Crash on macOS Big Sur when selecting the Tool Properties tab while the Brush, Pencil or Eraser tool is
active. SB-3459

« The marquee selection appears as a black rectangle in the Timeline after a right-click. SB-3995

o Quicktime movies created when exporting to EDL/AAF/XML on Windows always use the H.264 codec.
SB-3542

« setMovieConfig () isignored when exporting movies using the scripting interface and movies are
always created using the H.264/MPEG4 movie format. SB-3472

o Storyboard Pro stops working when creating a new project from a Final Draft file that contains
transitions. SB-3352

o Audio clips disappear from the Timeline when splitting the last panel before empty frames. SB-3349
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Storyboard Pro 7.0.2 Release Notes

Here is the list of changes in Storyboard Pro 7.0.2, build 17.10.2.16057 (2020-07-06):
o Timeline View on page 5
 Scripting on page 5
e Preferences on page 7

o Fixed Issues on page 7

Timeline View

Feature Description

The video track section retains its size when increasing and decreasing the
Enhancements height of the Timeline. This mimics the behavior from previous versions of
Storyboard Pro.

Scripting

Feature Description

The exportToHarmony () method was added to the ExportManager class to

export scenes to Harmony.
Export to Storyboard Pro
A script, TB_ExportToHarmony . js, which contains a usage example of this

method, has been added to the packaged scripts.

The settings used by the various ExportManager methods are now shared.
Shared export settings For more information, see the Generic export settings section of the
ExportManager class in the Storyboard Pro Scripting Reference.

Options to burn in a time code have been added to the options that can be set
through scripting in the ExportManager class.

The new options are as follows:

¢ setShowAdditionalDuration()
Burn-in time code ¢ setSplitTimeCountMode ()

e setSplitTimeCountSplit()

+ setShowTimeCode ()

For more information, see the Generic export settings section of the
ExportManager class in the Storyboard Pro Scripting Reference.
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Feature Description

Options to burn-in captions are now available in the ExportManager class.
Burn-in captions For more information, see the Caption burn-in settings section of the
Storyboard Pro Scripting Reference.

The setFBXExportDestination () and setFBXExportNamingPattern ()

Export destination and file
. methods have been added to the ExportManager class. For more
name pattern for exporting FBX . . A . .
fil information,see the FBX specific settings section of the ExportManager
iles

class documentation in the Storyboard Pro Scripting Reference.

The setVideoTrackSelection () method has been added to the
SelectionManager () class to select a video track by name. It can also be
used to select the storyboard (panel) track:

var sm = new SelectionManager () ;
Select video track

// Select the video track named V2
sm.setVideoTrackSelection ("V2") ;

// Select the Storyboard (panel) track
sm.setVideoTrackSelection ("TopLlLayer") ;

The new applyBlurToBitmap (), applyRadialZoomBlurToBitmap () and
. applyDirectionalBlurToBitmap () methods were added to the

Blur bitmap layers . ] .
LayerManager class to allow applying blur effects to bitmap layers using the

scripting interface.

The new setLayerAnimated () method of the MotionManager class allows
enabling and disabling animation on a layer:

Enable & disable layer var sb = new StoryboardManager () ;
animation var mm = new MotionManager () ;

var panelld = sb.panellInProject (6);
mm.setLayerAnimated (panellId, 0, false);

When using the ExportManager class to export a project for XML/AAF

conformation, the Expand Render Area to Scene Camera option can now be

Set Expand Render Area to set using the new setExpandRenderAreaToCamera () method.

Scene Camera option
For more information, see the FCP XML/AAF specific settings section of the

ExportManager class in the Storyboard Pro Scripting Reference.
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Preferences

Feature Description

A hidden preference was added to allow the selection and manipulation of
artwork in hidden layers.

To enable this preference, run the following line in the <<<Sandbox>>> script
of the Script Editor view, then restart Storyboard Pro.

preferences.setBool ( "HIDDEN LAYER SELECTABLE", true );

Fixed Issues

The following issues have been fixed in this release:

The selected movie format resets to H.264/MPG4 every time the Export Movie dialog is opened on
macOS. SB-3273

Renaming panels sequentially for the whole project using the TB_RenamePanelProject. js script,
can result in incorrect panel names if panel and scene names are locked. SB-2077

Rare crash when exporting to Harmony with the Apply Transformation on Drawings option enabled.
SB-3289

Hidden layers are included in scenes when exporting to Harmony. SB-3269

Rare crash on macOS when using the Select tool in the Stage View or Camera View while the Full
Scene Antialiasing preference is enabled. SB-3267

Export to Bitmap and Export to Layout commands overwrite files without warning when exporting a
subset of panels. SB-3266

Generating a PDF using the Preview button in the PDF Export view takes a long time on large projects.
SB-3262

Storyboard Pro sometimes freezes when stopping playback or scrubbing in the Timeline with audio
enabled. SB-3259

Captions written in Japanese don't spread properly when exporting to PDF. SB-3250
Copying a scene changes the Z value if the camera Z position is 1.0 SB-3164
The Split Current Scene command is not available in empty frames between panels. SB-2959

The addCtrlPointAfterPath3d () method of the FunctionManager class changes the point
before it isinserted. SB-3270

The scene. saveAs () method does not work properly. SB-2818
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o Renaming panels using the TB_RenamePanelByScene. js or TB_RenamePanelProject. js scripts,
while panels and scenes names are locked, can result in incorrect panel names. SB-2077

o Crash may occur when attempting to delete a control point with the Centerline Editor. SB-1750
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Storyboard Pro 7.0.1 Release Notes

Here is the list of changes in Storyboard Pro 7.0.1, build 17.10.1.15476 (2020-01-31):

o Animatic on page 9

» Captionson page 9

« Scripting on page 10

e Enhancements on page 10

o Fixed Issues on page 11

Animatic

Feature

Description

Drag & drop panels in Animatic
Editing Mode

Itis now possible to drag and drop panels at any specific position in the
timeline while . Animatic Editing Mode is enabled.

+

Captions

Feature

Description

Background colour

The Text Formatting toolbar and the Format Captions dialog now have a _.4
Background Colour button. This allows you to select a background colour for
the text in your project’s captions.

@ NOTE

The background colour appears around the text, like this, and does
affect the colour of the whole caption field.

Clear formatting

The Text Formatting toolbar and the Format Captions dialog now have a Y’
Clear Formatting button which removes all font, font size, bold, italic,
underline, text colour and background colour formatting from the selected
captions. It does not however affect the alignment of the text.
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Scripting

Feature Description

The new closeSceneAndOpenOffline () method of the scene class will
close the current project and open another.

Close project and open another @ NOTE

This method is named as such because it is also used in the Harmony
Stand Alone scripting interface to close a scene and open another.

The new setLayerLock () and getLayerLock () methods of the
Lock and unlock layers LayerManager class allow you to lock or unlock layers as well as to check
whether a specific layer is locked.

The exportSceneProgress () and exportFrameProgress () signals of the
. ExportManager class can be used while exporting your project using the

Export progress signals S . .
scripting interface. They are triggered every time a scene and a frame are done

exporting.

The new actNameOfScene () method of the StoryboardManager class will
Get the name of an act . . .
return the name of the actin which a given scene occurs.

The isEmpty () method of the LayerManager class now returns true if the
user has drawn inside the layer and then erased the artwork. Previously, it
would only return true if nothing had ever been drawn in the layer before.

Check if layer is empty @ NOTE

This change makes the method slightly slower as it requires loading the
layer’s drawing file to check if it contains no artwork. Also, please note
that the memory used by this method to load the drawing file cannot
be freed afterwards.

Enhancements
o Thedistance for the pen stabilizer in the Pen Settings toolbar is now set to 20 by default.

e The state of the O Loop Playback option is now saved to your preferences and preserved after closing
Storyboard Pro.

10
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Fixed Issues

Stability

o Memory leak and crash could occur when rendering QuickTime movies on macOS.

o Crash could occur when exporting a project as Harmony scenes while a 3D model is selected with the
-1 Layer Transform tool.

e Crash could occur when importing an AAF sequence for conformation while the Thumbnail view is
displayed.

o Ifthe Override Rotation, Override Zoom Out or Override Zoom In keyboard shortcut was cleared, the
Stage View and the Camera View would get stuck in Rotate, Zoom In or Zoom Out mode.

Project Creation & Saving

« When using the Save As command, the Save dialog would not always open in the project’s actual
location and the default project name would not always match the project’s name.

« When saving a new version of the project, the old version would remain marked as open which would
result in an error message when opening the old version.

o Scenes could be imported in the reverse order when creating a project from Harmony scenes.

« It was possible for the user to save a project even if no changes had been made.
Drawing & Layers

o Copying or duplicating layers inside groups would copy layers inside the group twice, once inside the
copied group and once outside the copied group.

« Scaling or rotating an animation-enabled layer with the i} Layer Transform tool would not create an
animation keyframe.

Storyboard & Animatic

o It became impossible to draw or manipulate objects in the Stage or Camera view after selecting a sound
clip and changing the current frame.

« It was not possible to select both video and sound clips simultaneously by drawing a rectangle around
them with the mouse.

« When copying and pasting a movie clip with animation keyframes over itself, only the keyframes in the
original clip that were not overwritten by the copy of the movie clip would get copied over.

« When adding a panel in a gap between two panels, if the panel was bigger than the gap, subsequent
panels would be offset but not their camera keyframes.

o Moving a scene between two other scenes caused Storyboard Pro to prompt the user to rename the
scene.

11
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o The Paste command was greyed out when the timeline playhead was in a gap between two panels,
making it impossible to paste panelsin a gap.

« It was previously impossible to delete an audio track that was locked.

« Selecting all panels from a specific point forward by holding Ctrl (Windows) or &8 (macOS) + Shift + Alt
and clicking on a panel then deleting the selected panels would occasionally delete sound clips outside
of the selected range and leave sound clips inside the selected range.

Captions

« When the Spelling dialog found a misspelled word for which it had no spelling suggestion, the Replace
Once and Replace All buttons would be greyed out, even if the user typed in their own replacement
word in the Replace With field.

o Spelling mistakes at the very end of a caption field did not get highlighted by the spell checker.

Import

o« When importing multiple video files that contain audio with the Overwrite Existing Clips option, only
one of the video file’'s audio streams would get imported.

o Attempting to import a Windows Media Video (.wmv) file on macOS would cause a progress bar to
appear, loop indefinitely and soft-lock the application.

NOTE
Importing WMV files is not supported on macOS.

« Storyboard Pro only allowed importing TIFF images with the . tif extension, and not with the . tiff
extension.

Export

o The Movie Settings dialog on macOS had an Alpha option, despite Storyboard Pro not supporting the
export of movies with transparency.

« An unclear error message would appear when attempting to export a movie in H.264/MPEG-4 (*.mov)
format in a resolution that is not supported by this video encoder. Now, a message explaining the issue
appears and prompts the user to export in a supported resolution instead.

NOTE

This video encoder supports resolutions of up to 4096x2304. Each dimension must be a
multiple of 16 pixels.

12
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« When exporting a movie that included an empty space in the timeline with burnt-in scene and panel

information, the scene and panel information for the next panel would be burnt-in during the empty
space section.

« Importing an AAF sequence for conformation would fail if it only contained audio tracks.

« When exporting a PDF in a vertical layout with the Expand Panels and the Spread Captions & Sketch
options, the captions for panels with long horizontal camera movements (which get printed to a row
below the thumbnail) would bleed outside of their respective caption fields.

Project Management

« The buttonsin the Project Management view would disappear when switching to another view then
back to the Project Management view when using the classic (light) stylesheet.

« When extracting a project from another project in Storyboard Pro Packed Files (.sbpz) format via the
scripting interface, the extracted project would be linked to the original project’s cache rather than the
actual project file.

« No error information would be written to the report field of the Merge Modified Panels dialog box if the
merge operation failed.

User Interface

o Textin the Sequence, Scene, Panel and Duration fields of the PDF Review workspace was cropped in
High DPI/ Retina mode.

o« The » expand and " collapse arrows would not appear in the same size in the Library and 3D Graph
views, depending on the colour theme used and whether Storyboard Pro was running in normal
resolution or in High DPI/ Retina mode.

13
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Storyboard Pro 7.0.0 Release Notes

Here is the list of changes in Storyboard Pro 7.0.0, build 17.10.0.15295 (2019-11-26):

o Drawing on page 14

o Drawing Guides on page 19

o Animatic on page 22

o Stage and Camera Views on page 23

o Script & Captions on page 24

» Videoon page 25

o Audioon page 25

o Images on page 27

o Conformation on page 27
o Export Movie on page 27

o Export PDF on page 28

e Project Management on page 28

o Preferences on page 29

o Installation & Packaging on page 31

« Scripting on page 32
e Enhancements on page 33

o Fixed Issues on page 33

Drawing

Feature Description

Itis now possible to add horizontal and vertical guides to the Stage View and
the Camera View. Alignment guides can be used with the i1 Layer Transform
tool as well as various drawing tools such as the ® Select, %% Contour
Editor, ) Perspective, &~ Brush, & Pencil, O Rectangle, O Ellipse and

/ Linetools, to help you position elements and draw along their axes.
Alignment guides

You can add the Alignment Guides toolbar to your workspace by either:

« Right-clicking on any toolbar and select Alignment Guides.

« Selecting Windows > Toolbars > Alignment Guides from the top
menu.

14
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Feature

Description

You can also add alignment guides by selecting View > Alignment Guides
from the top menu.

You can manipulate alignment guides using the . Layer Transform orthe W
Select tool. You can also make your drawing tool snap to alignment guides by
clicking on the @ Snapping button in the Tool Properties view and, in the
pop-up menu, select Snap to Alignment Guides.

New & updated brushes

The brush presets for the 4~ Brush tool have been updated.

« Solid vector brushes are now sorted by size, starting from 5 and going

to 25.

Solid Brush 1 m
5

Solid Brush 2 %
10

Solid Brush 3 ,.--—.\_-—/
15

Solid Brush 4 N
25

« Fine Pencil, Tilting Pencil and Chisel Tip brushes have been added.

Fine Pencil .

—
7
Tilting Pencil ,...—-\—'
20
Chisel Tip ‘_“‘h‘._.
20 '

« Charcoal has been updated, and its alternative, Charcoal Pencil, has
been replaced with Dark Charcoal.

Charcoal —M
20
Dark Charcoal —-.\“_-

20

Pen stabilizer

The new pen stabilizer can help you draw smooth, stable lines by stabilizing
your drawing strokes as you draw, without having to smooth them afterwards.
It works by letting you draw a stroke without generating a line immediately,
instead it starts generating a line that trails behind your mouse cursor or tablet
pen once it reaches a certain length. By trailing behind your stroke, it can
smooth out the flaws in your drawing gesture and generate a smooth stroke.

There are two different stabilizing methods:

« Average: Storyboard Pro calculates the average direction of all of your
mouse or pen gestures between the end of the actual drawing stroke

15
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Feature

Description

and the current position of your mouse cursor or pen tip, and extends
the stroke in this average direction, effectively evening out jitter and
rounding sharp turns.

« Pulled String: When you start drawing a stroke, Storyboard Pro
positions the drawing tool where your stroke starts. As you move the
mouse or tablet pen, the drawing tool remains in that position, but a
"string" appears, linking your drawing tool to your mouse cursor or pen

tip.

T :_

Once a certain maximum length is reached, the string pulls the drawing
tool in the direction of your mouse cursor or tablet pen.

The distance between your mouse cursor or tablet pen and the stroke can be
customized.

This feature can be enabled by adding the Pen Settings toolbar to your
workspace, and selecting either Average or Pulled String in the toolbar's
drop-down menu.

Pen tilt support

If you have a tablet and pen that support reading the tilt angle of your pen, you
can configure the Brush tool to use this information and draw with a tilted tip.
A tilted tip will be stretched or projected at the angle in which you tilt your
tablet pen, simulating the effect of drawing with a tilted pencil or felt pen.

N/

Pen tilted up or down

Pen tilted left or right

This feature can be used by adjusting the Pen Tilt Sensitivity parameter in the
Brush Properties dialog.
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Feature

Description

Pen rotation

If you have a tablet and pen that supports reading the rotation angle of your
pen, you can configure the Brush tool to use this information so that the
rotation of your brush tip is based on how you rotate your tablet pen.

A stroke with a square tip without pen rotation

A stroke with a square tip with pen rotation,
with the pen rotated at 45°

This feature can be used by enabling the Use Pen Rotation property in the
Brush Properties dialog.

Pen pressure feel editor

Storyboard Pro now allows you to edit and customize the curve by which it
processes the amount of pressure you put on your pen tablet to calculate the
thickness, flow or opacity of your brush or pencil lines.

The Pen Pressure Feel dialog can be accessed by adding the Pen Settings
toolbar to your workspace, then clicking on the 95 Pen Pressure Feel button.

Easy Drag

The X Selectand £ Cutter tools now have an Easy Drag mode. When
enabled, you can click anywhere inside the selection control box to drag the
selection. By default, you have to click inside the artwork, which may be
difficult when manipulating line art.

To enable Easy Drag mode, click on the [w/ Easy Drag button in the Tool
Properties view.

Lasso/Marquee Selection Mode

In the Tool Properties view, if you set the selection mode for the current tool to
either &> Lasso or Ix] Marquee, the mode will be automatically saved in your
preferences and will persist after you close and relaunch Storyboard Pro.

17
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Feature

Description

NOTE

The selection mode can be set when using the i1 Transform, X
Select, £z Cutter, % Contour Editor, % Pencil Editor, A

Perspective or % Envelope tools. Setting the selection mode for any
of these tools will change the selection mode for all of these tools.

Keyboard shortcut for Draw
Behind

Itis now possible to assign a keyboard shortcut to toggle the N Draw Behind
tool property. This shortcutis listed as Draw Behind under the Drawing Tools
section of the keyboard shortcuts list, and has no default assignment.

Tip Style option for the Eraser
tool

The é\" Eraser and now has a . Tip Style option in the Tool Properties view.
This option allows you to select which style of tips will be Left over when you
erase part of a pencil line.

r—r
Rraundtjp;-.-
—

-

/I

Eraser stroke ]

—s

Tip Style option for the Contour
Editor tool

The % Contour Editor tool now has a . Tip Style option in the Tool
Properties view. This option allows you to select which style of tips will be
Left over when you select and delete a pencil line segment with the %
Contour Editor tool.

18
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Feature Description

Pr
7~
S~ —

T
[ Segment to remove ]

Drawing Guides

Feature Description

Several new drawing guides have been added:

o The Ruler allows you to position and rotate a simple straight axis, and
then draw a line along that axis, like a regular ruler.

.

« Thelsometric Perspective guide helps you draw lines that are parallel
to one of three axes: The x-axis, the y-axis and the z-axis. The angle of
each axis can be customized as needed.

This type of pseudo-perspective, also referred to as parallel projection,
is often used in 2D games, computer graphics and schematics to depict
3D objects and environments without using any actual perspective,
foreshortening or 3D rendering. In 2D animation, itis often used to
draw long panning backgrounds from a low or high angle.

New drawing guides

.

« The 3-Point Perspective (Horizontal Pan) guide helps you draw
horizontally panoramic backgrounds, with curvilinear horizontal lines.
A vanishing pointis placed in the middle of the horizon line, to help
draw lines on the z-axis, and two vanishing points are placed on the
horizon line outside of the camera field, to define the curve of
horizontal lines. Vertical lines are made perpendicular to the horizon

19
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Feature Description

line.

This is useful for drawing backgrounds meant to be panned over
horizontally. Panning the camera horizontally over a background
drawn with a 3-Point Perspective (Horizontal Pan) guide will simulate
a rotation of the camera on the y-axis.

o The 3-Point Perspective (Vertical Pan) guide helps you draw
vertically panoramic backgrounds, with curvilinear vertical lines. A
vanishing pointis placed in the middle of the horizon line, to help draw
lines on the z-axis, and two vanishing points are placed above and
below the horizon line, outside of the camera field, to define the curve
of vertical lines. Horizontal lines are made parallel to the horizon line.

This is useful for drawing backgrounds meant to be panned over
vertically. Panning the camera vertically over a background drawn with
a 3-Point Perspective (Vertical Pan) guide will simulate a vertical
rotation of the camera on the x-axis.

o The 4-Point Continuous Perspective guide is very similar to the 3
Point Perspective (Horizontal Pan) guide, except that it is designed to
help draw full 360° panoramic backgrounds.

This guide uses 5 vanishing points. When drawing a horizontal line, it
is curved by arching over one of the vanishing points and reaching
down to the two surrounding vanishing points. This creates a
perspective effect where each vanishing point represents one of the
cardinal points, except that the leftmost and the rightmost points
represent the same cardinal point, effectively creating a looping
background. Backgrounds made with the 4-Point Continuous
Perspective guide can be looped horizontally to simulate a full rotation
of the camera on the y-axis.

20
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Feature Description

o The 4-Point Perspective (Vertical Pan) is a lot like the 2-Point
Perspective guide, except that its vertical lines are curvilinear, so it can
be used to make vertically panning backgrounds. Two vanishing points
are on the horizon line, outside of the camera field, to help draw lines
on the x-axis and the z-axis, and two vanishing points are placed above
and below the camera field to define the curve of the vertical lines.

This is useful for drawing backgrounds meant to be panned over
vertically, in which cuboid objects are seen from an angle.

o The 5-Point Perspective (Fish Eye) guide helps you draw
backgrounds that are curvilinear on both the x-axis and the y-axis. It
has one central vanishing point on the horizon line, from which lines
on the z-axis are drawn, two vanishing points at the extremities of its
horizon line, to define the curve of horizontal lines, and two vanishing
points above and below the horizon line, to define the curve of the
vertical lines.

This guide can be used to draw backgrounds with a fisheye-style wide
angle lens effect. It can also be used to draw backgrounds that are
meant to be panned in various directions.

Each guide is available in the <4 Add Guide pop-up menu of the Guides view.

21
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Feature

Description

Locking the guide angle

If you press and hold the Alt key while using drawing guides, the angle of the
guide lines will stop following your mouse cursor and lock in position until
you release the Alt key, allowing you to keep the guide lines at the right angle.

By using this feature, you can rework the thickness or length of lines that you
are drawing with a guide. It's also useful if you want to draw a dotted line
along an axis.

Guide angle display

When you rotate a guide, its exact angle is displayed in the top-left corner of
the Stage and Camera views.

Rotating guides from centre

Some guides can be rotated by moving one of the two points on their horizon
line, which rotates them around the opposite point. If you press and hold the
Alt key while moving one of their points, it will rotate the guide around its
centre instead. This works for the following guides:

o Ruler
o 2-Point Perspective
o 3-Point Perspective (Bird's-Eye View)

o 3-Point Perspective (Worm's-Eye View)

Animatic

Feature

Description

Animatic editing mode

Itis now possible to create gaps in your animatic when editing its timing,
similarly to editing video clips in a video editing software.

[ Gapbetween ] [ Gap between scenes]

By default, any change you make to your animatic will ripple to subsequent
panels so as to avoid leaving gaps in the timeline. If you want to create gaps,
you must enable Animatic Editing Mode. This can be done by clicking on the
‘ Animatic Editing Mode button in the bottom-left corner of the Timeline
view. You can also temporarily toggle Animatic Editing Mode by pressing and
holding the Ctrl (Windows) or 3£ (macOS) key while changing the duration of
a panel in the Timeline view.

22
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Feature

Description

NOTE

Projects with gaps in their timeline cannot be opened in older versions
of Storyboard Pro.

Enable & disable clip
synchronization by track

By default, when you offset panels, sound clips and video clips that are cued
during those panels will also be offset to remain synchronized with them.

You can now disable the synchronization of video and sound clips for each
video and audio track in your project. When synchronization is disabled for a
track, its clips will not offset when you make changes to the timing of your
animatic.

To disable synchronization for a track, click on the -,L Sync button next to that
track in the Timeline view.

Separate video and audio
sections

The Timeline view is now divided in two separate areas:

o Thevideo area, which contains your storyboard track, which has your
project's panels, animations and camera movements, as well as all of
your project's video tracks.

o The audio area, which contains all of your project's audio tracks.

Itis possible to reposition the divider between these two areas and to scroll
each area vertically without affecting the other area.

Navigate to previous and next
sequence

Commands to instantly navigate to the previous or the next sequence have
been added to the Play menu.

Those commands can also be added to the Navigation toolbar, which, by
default, only has the °€ Panel First Frame and the »° Panel Last Frame
buttons. You can customize this toolbar by right-clicking on it and selecting
Customize.

You can also assign keyboard shortcuts to the Previous Sequence and Next
Sequence commands, in the Play/Navigation section of the Keyboard
Shortcuts dialog.

Stage and Camera Views

Feature

Description

Overlays

Where you could previously only display the current frame's time code as an
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Feature

Description

overlay in the Stage and Camera views, you can now also display the name
(number) of the current scene and the current panel, as well as one type of
captions.

You can also customize where this information is displayed, as well as its font,
font size and colour.

To display overlays in the Stage and Camera view, click on the Show
Overlays button in the toolbar at the bottom of either view.

To customize the types of information displayed in the overlays, as well as
how itis displayed, double-click or long-click on Show Overlays and, in
the pop-up menu, select © Overlay Settings.

Multiple Camera views

Itis now possible to have several instances of the Camera View in your
workspace.

For example, you can now add a detached Camera View window to your
workspace, and position it inside your workstation's second monitor. Your
second monitor can then act as a preview and playback monitor.

Each Camera View in your workspace has its own zoom level and angle.
Additionally, the Action Safe Area, Title Safe Area, 4:3 Safe Area, 4:3 Area,
Camera Mask and Show Overlay switches can be toggled independently on
each Camera View.

Script & Captions

Feature

Description

Spell Checker

Storyboard Pro now has spell checker functionality. It checks the spelling of
each word in your captions and in your project's script and underlines the

words it does not find in its dictionary. It also allows you to go through each
misspelled word in your project so that you can either correct or ignore them.

By default, automatic spell checking is enabled. To toggle it off, select
Caption > Spelling > Check Spelling While Typing from the top menu.

To go through each spelling mistake in your project, or to select which
dictionary to use to check your spelling, select Caption > Spelling > Spell
Check from the top menu.
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Video

Feature

Description

Import audio stream

When importing a movie file, you can now import its audio stream into your
project's audio tracks by checking the Import Audio checkbox in the Import
Videos/Images as Clips dialog.

Video with transparency

Storyboard Pro now supports videos with alpha (transparency).

Import WebM

Itis now possible to import WebM files as video clips into your animatic.

@ NOTE

Importing the audio stream of a WebM file is currently not supported.

Use drawing layer as video clip

Itis now possible to convert a drawing layer into a video clip. To do this,
simply click and drag on a drawing layer, and drop it inside a video track.

Drag & drop movie file

You can now drag and drop a movie file from your operating system's file
browser into one of your project's video tracks. This will instantly import the
movie into the video track in which you dropped it.

Audio

Feature

Description

Sound clip volume

You can now set the volume for a sound clip without creating a volume
keyframe. You can simply click and drag on their volume envelope to adjust
their overall volume.

RR_Line04_Terrance_02.wav

If your sound clip has volume keyframes, you can also click and drag on the
segment between two keyframes to offset both keyframes simultaneously.
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Feature Description

RR_Line04_Terrance_02.wav

+1.68 dB

Itis possible to add a gain effect to sound clips. To do this, select one or
several sound clips, then either:

« Right-click on the selection and select Audio Gain.
o Inthetop menu, select Clips > Audio Gain.

Gain is different from volume in that it can actually amplify your sound clip. It
is applied before the volume is applied. It is possible to select several sound
Gain effect clip and set or offset their gain simultaneously. Hence, if you notice disparities
in volume between different sound clips, you can quickly even them out.

Audio Gain is an effect which can be adjusted or undone at any time. Itis
supported with XML and AAF conformation. This means that if you export
your animatic as an XML or AAF sequence for conformation and import the
sequence in Final Cut Pro, Adobe Premiere and Avid Media Composer, you can
adjust the gain on your sound clip in your video editing software, and import
those changes into your Storyboard Pro project.

When setting the volume of a sound clip or of a volume keyframe, the overlay
that displays the volume you're setting it to in decibels now displays decimals.

RR_Line04_Terrance_02.wav

Precise volume control

You can now drag and drop a sound file from your operating system's file
Drag & drop sound file browser into one of your project's audio tracks. This will instantly import the
sound file into the audio track in which you dropped it.
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Images

Feature

Description

Drag & drop image file

You can now drag and drop an image file from your operating system's file
browser into Storyboard Pro to import it as a layer in a panel, or as an image
clip in a video track.

You can drop the image file into the following areas of the user interface:

o In the Stage View, Camera View or Layers view, which will import it as
a layer in the current panel, on top of all the other layers.

o Inthe Thumbnail or Timeline view, over the thumbnail for a panel,
which willimport it as a layer in that specific panel.

o Inavideo track in the Timeline view, which will import it as a static
image clip.

Conformation

Feature

Description

Updating sound files

When importing an XML sequence for conformation, Storyboard Pro will
check if the sound files linked to your sequence have been changed since they
were exported from your project. If changes have been detected, Storyboard
Pro will import the new sound files into your Storyboard Pro project.

Gaps in timeline

Since itis now possible to create gaps in the timeline of your animatic, itis
also possible to import a sequence containing gaps for conformation. Gaps in
your sequence will be imported into your animatic.

Export Movie

Feature

Description

Exportin H.264 (AVC)

Itis now possible to export a QuickTime Movie (.mov) file without using Apple
QuickTime, by instead using a simple H.264 (AVC) encoder.

To do this, when using the Export to Movie or the Export to EDL/XML/AAF
dialog, select H.264/MPEG-4 (*.mov) in the Movie Format drop-down. This
format is available on both Windows and macOS, even if Apple QuickTime is
not installed.

Movies exported using this option have a video stream encoded with the H.264
(AVC) video codec, and an audio stream in PCM format.
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Feature

Description

New QuickTime movie interface
for macOS

On macOS, Storyboard Pro now uses the Apple AVFoundation framework that
is built into macOS to export movies in QuickTime Movie (.mov) format, instead
of the QuickTime application.

This allows Storyboard Pro to encode video using the H.264, Apple ProRes
442 and or Apple ProRes 4444 codecs built into AVFoundation.

Export PDF

Feature

Description

Better visual indication of
scenes in Japanese storyboard

When exporting a PDF using one of the Japanese PDF profiles, horizontal
lines are drawn in the CUT and TIME columns to indicate when a scene ends
and the next scene starts.

Project Management

Feature

Description

Versioning

Itis now possible to save multiple versions of your storyboard without having
to save your entire project as a copy.

By selecting File > Save as New Version from the top menu, you can save
your project as a different project file, but inside the same project folder.

Each project version will preserve their own animations, timing, video tracks,
audio tracks and clip placements. However, the different versions of a single
project will share the same drawing files, video files and audio files, as well as
the same palette.

Project versions will be saved as different . sboard files inside the project
directory. To open a specific project version, simply open the corresponding
project file.

You can also save different project versions when working with Storyboard
Packed Files (. sbpz). If you open a Storyboard Packed File that contains
several project versions, you will be prompted to select which version you
want to open.

Project Management view

The new Project Management view allows you to keep a list of all the projects
that were created by splitting your project or by extracting parts of your
project.

28



Toon Boom Storyboard Pro 7.0.4 Release Notes

Feature

Description

When you split your project, or when you extract smaller projects from your
project, you can check the Link extracted project at the bottom of the Split
Storyboard or Extract Storyboard dialog to add the smaller projects to the list
in the Project Management view.

This list displays the name as well as the full path to each project. It also
indicates whether or not the project was modified, as well as if the project
cannot be found in the location where it was extracted.

This view also allows you to remap linked projects that were moved and to
remove linked projects that were deleted, and to link other projects to yours. It
also provides a quick access to all the commands that are available in File >
Project Management in the top menu.

Merge modified panels

Using the new Project Management view, you can select a project in the list of
linked projects, then click on the 2= Merge Modified Panels from Selected
Project button to import all the changes from the child project into your parent
project.

@ NOTE

The first time you click on this button, you will be prompted to select

some merging options. Afterwards, merging changes from a linked
project will require a single click.

You can also use the Merge Modified Panels dialog to browse for a project and
select the merging options before you import it.

Preferences

Feature

Description

User interface language

Itis now possible to select your preferred user interface language in the
Preferences dialog.

Storyboard Pro currently supports English, Chinese (Simplified), Japanese and
Spanish. In previous versions, Storyboard Pro would always launch in the
language of your operating system if supported, or in English otherwise. By
setting this preference, you can make Storyboard Pro launch in a specific
supported language regardless of the language of your operating system.

You can change this preference in the Global Ul tab of the Preferences dialog.

Panel number incrementing

The Increment name by preference allows you to configure how new panels
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Feature Description

are numbered.

For example, if you enable this preference and set it to 10 (the default value),
panels in a new scene will be named 10, 20, 30, and so on when created in
sequence.

Then, if you create a new panel between two existing panels, the new panel
will be named by using the number between the numbers assigned to the two
neighbouring panels, rounded down. For example, if you create a panel
between panel 10 and panel 20, this panel will be named 15. If you create
another panel between panel 10 and 15, this panel will be named 12. When
this option is disabled, if you create a panel between two existing panels, the
new panel will be named based on the number of the previous panel + 1, and
subsequent panels will be renamed to keep their numbers in sequence.

This preference is available in the Naming tab of the Preferences dialog.

A new panel naming rule has been added.

This new panel is very similar to an existing panel naming rule, it uses letters
instead of digits to number panels, in the following way:

A..ZZA..Z2,7ZA ... ZZZ, Z7ZA ...

However, while the existing naming rule added Zs at the beginning of the
panel's name to count how many times it reached Z, this new rule indicates the

New panel naming rule . . . ]
amount of Zs it reached using a number, in this way:

A..ZZA..ZZ 2ZA .. 272, 3ZA ...

Hence, panel names always use at most two letters, and are otherwise
preceded by a number.

You can select this naming rule in the Naming tab of the Preferences dialog, in
the Panel Auto-increment Rule drop-down.

The new Automatically Add Leading Zeroes preference, available in the
Naming tab of the Preferences dialog, allows you to create panels with a

Panel name length specific amount of digits in their name, by adding leading zeroes as needed.

For example, if you set the minimum amount of characters for panel names to
3, the first panel of a scene will be named 001.

When applying a blur effect on a bitmap layer, by default, Storyboard Pro uses
your computer's graphics processing unit (GPU) to generate the blurred image
Disable using GPU for effects faster. This may not work as expected on some video cards. If you encounter
this issue, you can now fix it by disabling the Render effects using GPU
(OpenCL) preference in the Advanced tab of the Preferences dialog.
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Feature Description

The Shortcuts tab of the Preferences dialog is now its own dialog, the

Keyboard Shortcuts dialog.
Keyboard Shortcuts dialog
To access this dialog box, in the top menu, select Edit (Windows) or

Storyboard Pro 7 (macOS) > Keyboard Shortcuts.

Itis now possible to create your own keyboard shortcut sets. You can also

Create, export, import and export your keyboard shortcut sets as XML files and use them as backups or

switch between keyboard share them with project collaborators.

shortcuts sets You can create, export and import keyboard shortcut sets using the New,

Load... and Save... buttons at the top of the Keyboard Shortcuts dialog.

Itis now possible to export your preferences as XML files, and use them as

backups or share them with project collaborators.
Export and import preferences
You can export and import preferences using the new Load... and Save...

buttons at the top of the Preferences dialog.

Storyboard Pro now comes preloaded with three different sets of default
Default preference sets preferences: Standard, Animatic and 3D. You can quickly switch between
these sets in the Preferences dialog.

Installation & Packaging

Feature Description

The Storyboard Pro package for macOS now only contains a single

application.
Single application on macOS
You can launch License Wizard by selecting Storyboard Pro 7 > Storyboard

Pro Tools > License Wizard from the top menu.

The way Storyboard Pro is packaged for macOS no longer triggers the
operating system's security mechanisms. Hence, itis no longer required to
L right-click on Storyboard Pro, select Open and authorize the application as a
Easy authorization on macOS . o . o ]
user with administrative privileges to be able to run Storyboard Pro. You will
be able to launch Storyboard Pro as soon as it is copied to your Applications

folder.

N 39-bit tabl. All 32-bit executables have been removed from the packaging on macOS to
© more texecutables ensure that Storyboard Pro can run on macOS 10.15 (Catalina), which dropped
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Feature Description

support for 32-bit applications.

@ IMPORTANT

In previous versions of Storyboard Pro, it was possible to open projects

in the legacy project format created by Storyboard 1 and to convert
them to the new format. This conversion used the 32-bit Sboard2Xml
utility, which is no longer packaged with Storyboard Pro. As such, as of
Storyboard Pro 7, it is no longer possible to open projects in the legacy
Storyboard 1 format.

Scripting

Feature Description

In the past, scripts packaged with Storyboard Pro were all automatically
copied to your preferences folder, in the same location as your custom scripts.
Now, scripts packaged with Storyboard Pro are only copied to your
preferences if you make modifications to them. Otherwise, they are stored and
executed from the Storyboard Pro installation folder.

This solves several problems:

o The scripts folder in your user preferences is now reserved for your

. custom scripts and are no longer cluttered with Storyboard Pro scripts.
Smart Script Management

« In previous versions, when installing a patch update, Storyboard Pro
would not overwrite the scripts in your user preferences with the
updated scripts, as this would risk overwriting one of your user scripts.
This is no longer a problem, except in the rare case where you happen
to have edited a script packaged with Storyboard Pro which was
updated in a patch update.

« You can now easily restore the original version of a packaged
Storyboard Pro script after having made changes to it.

You can now set a custom location in which to store scripts. To do this, you
must set the TOONBOOM GLOBAL_ SCRIPT_ LOCATION environment variable to
Custom Script Folder the location where you want to store scripts. The scripts in this location will
be available in the Script Editor alongside scripts that are packaged with
Storyboard Pro and scripts in your user preferences.

Itis now possible to export your project as an EDL, AAF or XML sequence

E rt to EDL/AAF/XML
Xportto IAAFIX through scripting. You can do this by using the exportToNLE () method of
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Feature Description

the ExportManager class.

The setOneMoviePerPanel () method was also added to the
ExportManager class to support exporting one movie file per panel.

The scripting interface now provides you with a list of responders from the
Storyboard Pro user interface. You can obtain this list with the

User Interface Responders . . . .
getResponderList () method. You can obtain the list of actions for a given

responder with the getActionList () method.

. . The following methods were added to the scene class to convert the
Convert a coordinate for single . ] . ) . .
coordinate for a single axis from field coordinates to OpenGL coordinates, and
from OpenGL to field coordinates: toOGLX (), toOGLY (), toOGLZ (),

fromOGLX (), £romOGLY () and £romOGLZ ().

axis between fields and
OpenGL coordinates

The new getMajorVersion (), getMinorVersion (), getPatchVersion ()
Get individual version numbers and getBuildNumber () methods of the about class will provide their
respective values from the currently installed version of Storyboard Pro.

Enhancements

e The T Texttool now remembers the last font you used with it.

o Storyboard Pro now supports True Type Collection (. tte) fonts. These are font packages containing
several True Type Font (. tt£) files. If you have any TTC font installed on your system, you will be able
to use them with the T Text tool, when formatting captions as well as in Burn-in options when
exporting your project.

o The Terminology Style option was removed from the Japanese localization of Storyboard Pro, as
Japanese terminology is the same for animation and live action.

o The Start Dictation and Emoji and Symbols menu entries have been removed from the Edit top menu.
These entries were automatically added by macOS and were not compatible with Storyboard Pro.

o Toolbarsin the top menu and the context menu are now listed in alphabetical order.

« Viewsin the top menu are now listed in alphabetical order.

Fixed Issues
The following issues have been fixed in this release:
o Storyboard Pro fails to launch on macOS 10.15 Catalina.

« Storyboard Pro crashes when undoing changes done with the X Centerline Editor tool.
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On Windows, when drawing a very long brush stroke with a pen tablet then immediately drawing
another stroke, the second stroke starts off with a straight line segment.

The Spacebar key can still be used to pan views after the user unsets it as the keyboard shortcut for the
Free Pan and Zoom command.

Mouse pointer becomes default mouse pointer when a notification appears on macOS.
Storyboard Pro fails to import XML sequences exported from OpenTimelinelO for conformation.

Custom Write node parameters are not exported when exporting Harmony scenes with the Rendered
Animatic option.

Exporting a storyboard in PDF format by running a Storyboard Pro script in a command line interface
may cause it to have missing information and garbage text.

When using the £ Stamp tool with the & Draw Behind tool mode, the different strokes in the
stamp's artwork are laid on the canvas in their reverse order.

Using the £ Cutter tool on multiple drawings makes some of the selected artwork turn red.

On macQOS, attempting to Save As causes Storyboard Pro to freeze if a folder with the same name as
your project name exists in the target directory.

Attempting to Save As inside the project folder will cause the ensuing error message to keep
reappearing indefinitely.

Storyboard Pro crashes if the user cuts and paste a clip, then undoes and pastes again.
Selecting View > Show Tab Bar from the top menu may cause Storyboard Pro to crash on macOS 10.12.

When using the [ Rectangle, O Ellipse or / Line tool with the %i Snap and Align tool mode,
scrolling in or out of the drawing space causes the alignment hints to be offset.

Pressing the Del (Windows) or (macOS) causes Storyboard Pro to crash in the following
circumstances:

« When moving a camera keyframe.

« When adjusting the in-point, out-point of a sound clip, or when moving one of its volume
keyframes.

« When moving an animation keyframe in a video clip.

Pressing Del (Windows) or (macOS) to delete the selected panel while attempting to resize it resizes
the previous panel.

Attempting to import a 3D model into a 2D scene while the timeline playhead is past the last panel in
the project, then cancelling, causes Storyboard Pro to crash.

Attempting to add a scene between two scenes and then cancelling may cause Storyboard Pro to crash
if a custom default panel layout is saved to the user's preferences.
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o Attempting to import an XML sequence that contains video files instead of images for conformation
causes Storyboard Pro to crash.

o Camera frame in Stage View and Camera View is too thin when using a High DPI (Windows) or Retina
(macQOS) display.

« When duplicating a panel containing vector artwork imported from a PDF, the layers in the duplicate
panel are copied from different panels.

o Inthe Timeline view, the zone in which a template can be dropped toinsert it as a new panel at the end
of the scene is too narrow and is easy to miss.

o Theoverlay indicating a volume keyframe's value in dB remains on the screen when dragging the
keyframe outside the sound clip to delete it.

o Crash may occur when attempting to add a new sequence while the Timeline View playhead is beyond
the last panel.

o Ifthe user extracts a scene from a project, deletes the extracted project and extracts the same scene in
the same target folder with the same name, the audio in the extracted project will be corrupted.

« Moving panelsin the Timeline view has no effect if the Timeline view is not docked to the main
application window.

« Main application window does not appear if workspace configuration file is invalid or corrupted.

« When drawing a closed shape with the @ Auto Fill tool mode and a custom colour that does not exist
in the project's palette, the shape gets filled with red.

« Playback skips frames when playing a project for the first time since opening it on macOS.
o Exporting a Windows Media Video (.wmv) movie at 100% quality creates a corrupted movie file.

o The value of volume keyframes, displayed in decibels, is slightly inaccurate relative to their actual value,
which is stored in amplitude ratio, in the project file.

« Drawing stroke does not appear until it is completed when drawing with the # Pencil tool with the ®
Draw Behind tool mode enabled and while using any modifier key.

o The iyl Easy Drag mode of the ® Select tool does not work when pressing and holding the 3£ key on
macOS.

e The @ Show / Hide button for a video track does not work properly if the timeline playhead is over a
video clip, but not over a panel.

o Left and right area of the Timeline view end up scrolled at different positions when clicking and
dragging on the timeline playhead up and down to make it scroll vertically.

o The Export Current Image command does not work when there are video clips but no panel at the
current frame.
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When making a PDF preview of a panel using the Panel PDF Options view, if the PDF profile has a
background image, it will obscure everything in the PDF preview except for the thumbnails and the
logo.

When using Storyboard Pro to run a script in a command line interface, the process does not terminate
and outputs the following error:

QThread: Destroyed while thread is still running
Pasting formatted text in a caption field may result in lines temporarily overlapping each other.

Attempting to open a Storyboard Pro Packed File that was created in Japanese trial mode (.tbpz) in full
license mode results in Storyboard Pro attempting and failing to open an empty project.

Entry in the Undo menu for updating the position of a 3D model rendered into a 2D layer has no text.

It is possible to edit the artwork in a locked or hidden layer using the ® Select, 2 Cutter, 24
Perspective, Edit Gradient/Texture, & Eraser, ® Paintor (> Close Gap tool if the artwork in this
layer is selected using the Select All Drawings in Scene option of the & Select tool or by selecting
the locked or hidden layer among others layers and selecting the artwork with the & Select tool.

PDF Export view is not listed in the right alphabetical position in the s= Add View menu.
No progress bar displays when saving a project on macOS.

Checked state of the Remove exported panels from current project checkbox in the Split Storyboard
dialog is saved even if the user clicks Cancel.

Adding a transition fails if the default panel length is set to 3 frames or less and the Preserve project
length when adding transitions preference is enabled.

When a group layer is selected, its name does not appear in the status bar.
Tool tip for the Overwrite Clips button is "Overwrite Sound Clips".
Centre is misspelled "center" in various user interfaces.

Error message when attempting to open a project created in Japanese trial mode in full license mode is
not localized in languages other than English.

Adding a transition between two scenes offsets the video and sound clips cued during the second scene
backwards.

"Brush 1" is missing from the &~ Brush tool presets.

The Perspective tool has an Align to Grid tool mode, which should only be available in Harmony.
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